
FrameMaster is a product that allows you to add stunning photo frames and various 
border effects to digital images. Start with an image on disk or capture an image from 
a scanner or digital camera directly from FrameMaster. Then simply apply a photo 
frame, overlay, mask, drop shadow, and various other border effects quickly and 
effortlessly. 

FrameMaster's intuitive user interface allows you to use its features quickly and 
efficiently. You will be up and running in no time at all. 

FrameMaster can be used to embellish photos for a wide variety of reasons. 
FrameMaster's effects can be used to spice up web-graphics and even gives you the 
ability to create buttons and create drop shadows.

FrameMaster allows for flexible printing options, including, photo scaling, centering, 
and resizing for common photo 

sizes, 4" x 6" and 3" x 5". 

FrameMaster is customizable. You can easily create your own custom frames, 
overlays, masks, and patterns to be used with FrameMaster.



 

FrameMaster allows you to copy images to and from the Windows clipboard. You can 
copy images from FrameMaster to the Windows clipboard so that the image may be 
used by other applications and visa versa. 



Some of the features of FrameMaster include: 

The ability to acquire images from a scanner, digital camera, or other capture ttwain) 
devices. 

The ability to add Ornate Frames to images, quickly and easily from a selection of 
over 100 ornate frames. 

The ability to apply Overlays to images. Overlays allow you to add nice touches to 
photos, giving them a custom look. 

The ability to apply Masks to images, allowing you to make interesting alterations to 
photos. 

The ability to create Drop Shadow effects on images. 

The ability to Buttonize an image allowing you to transform animage into a shaded 
button. 

The ability to create a variety of effects including Jagged effect, Box effect, Bubble 
Effect, Diamond effect, Oval effect, Standard Photo Frame and Frame Matte effects. 

Printing capabilities, including scaling features that easily print 4" x 6", 3" x 5", and 8" 
x 11.5" sized photos. 

FrameMaster also includes a feature allowing you create a photo sheet of your 
image. 

Supports a variety image formats.



FrameMaster provides over 100 Ornate Frames to embellish photos. 

1. Select Ornate Frame from the Frame menu. 

2. Click on the frame icon to pull down a list box of Ornate frames. 

3. Double-click on the desired frame from the list box. The frame you chose will now 
be applied to the photo. 



An Overlay is an image that is superimposed over the your photograph. The white 
regions in the overlay files are transparent and have no effect on the original image. 
All other non-white regions overlay the original image. The overlays are scaled to the 
exact size of the photo. 

Overlays can be used to apply border effects, banners, insignias, etc. to images. You 
can also install your own overlay files. Simply copy them to the Overlay directory of 
the FrameMaster program. 

To apply an Overlay to an image, you must do the following: 

1. Select the Frame menu. 

2. Select Frame Overlay. 

3. Click on the frame icon to pull down a list of Overlays. 

4. Double-click on any of the overlays in the list box to select that frame. 



Masks are grayscale images that allow you alter photographs by applying the mask to 
the original image. Darker regions of the mask darken the same regions in your 
image, while lighter regions of the mask lighten those corresponding regions. White 
regions of the mask do not affect the original image. These masks when applied to an 
image can create interesting effects. 

You can also darken or brighten the masks to alter the effect. 

Masks seem to work best when applied to photos with a uniform color in the border 
regions.



FrameMaster gives you full control over printing, here are some of the features: 

1. Landscape or Portrait Mode

2. Scaling capabilities

3. Center, Left, Right, Top and Bottom Alignment

4. Ability to scale to common photo sizes 4" x 6", 3" x 5"

5. Ability to print an entire sheet of images, example create a set of wallet-sized 
pictures.



You can add your own custom frames, overlays, and masks to FrameMaster by 
copying your images files to the proper directories. Keep in mind that the images 
need to be in Windows Bitmap format. 

...\FrameMaster\Ornate - contains the Ornate frames 

...\FrameMaster\Overlays - contains the Overlays 

...\FrameMaster\Masks - contains the Masks 

...\FrameMaster\Pattern - contains the Fill Patterns 



To create your own Ornate frame for use with FrameMaster do the following: 

1. Create a Bitmap that is a perfect square. This Bitmap will represent a section of the 
upper frame. For the best    results make sure it is symmetrical. FrameMaster will do 
the rest.    Usually a 40 x 40 pixel Bitmap provides good results. 

2. To save your .bmp image, you must use the following naming convention: 

_ORNxxx.BMP (where xxx = unique frame number). 

3. Finally copy the file to the “Ornates Frames” directory. 

If you want to use clip art, use the same guidelines as above but use the naming 
convention of CLIPxxx.BMP (where xxx =unique frame number).



To create your own Overlays to be used with FrameMaster you must do the following: 

1. Create a Bitmap (preferably with a descriptive name for the pulldown listbox). Make 
all regions of this overlay white    if you want that region to be transparent. All other 
non-white regions will be superimposed over the original image. The Overlay will be 
scaled automatically to fit the original image. 

2. When finished creating the Bitmap, copy it to FrameMaster's Overlay directory.



To create your own Masks to be used with FrameMaster you must do the following: 

1. Create a grayscale Bitmap (preferably with a descriptive name for the pulldown list 
box). Make all regions of this    overlay white if you want that region to be transparent. 
All other non-white regions will be masked with original image. The Mask will be 
scaled automatically to fit the original image. All dark regions of the Mask will darken 
the look of the original image. All lighter regions of the Mask will lighten the original 
image. 

2. When finished creating the Bitmap, copy it to FrameMaster's Mask directory.



A Fill Pattern is used to fill backgrounds with patterns instead of solid colors. A Fill 
Pattern must be an 8 x 8 pixel    Bitmap. 

When finished creating the Bitmap, copy it to FrameMaster's Patterns directory.



Minimal system recommendations include a 166 MHZ processor, a true-color 
graphics card, and 32 Megs of RAM. 

64 Megs of RAM are recommended, especially if you are dealing with large files 
(example: scanned images).

For more information contact: techsupp@galleriasoftware.com 

Galleria Software

11514 Galleria Drive

Tampa FL 33624



To register FrameMaster, you must first obtain a registration key. Follow this link to the 
RegSoft ordering system to    place your order and receive your registration key. 

Once you have obtained the registration key, you can unlock FrameMaster by 
entering the registration key. To do this, run FrameMaster and select the registration 
feature. 

Personal license: $17.95

Commercial license: $39.95

If ordering by phone, please specify PRODUCT CODE 32256.

In the United States: Toll-Free Order Phone Number: 1-877-RegSoft (1-877-734-
7638)

International Order Phone Number: +1-770-319-2718

Fax Orders: +1-770-497-9234 

Users sending faxes should be sure to include a mailing address. 

Money Orders and Check Orders (include email address to quickly recieve 
registration key): 

Galleria Software

11514 Galleria Drive

Tampa FL 33624



IMPORTANT-READ CAREFULLY 

1. FrameMaster End User License Agreement 

A. License: The License Agreement grants the user of this copy of FrameMaster a 
license to evaluate one copy of FrameMaster for 30 days. Thereafter the software 
may not be used until a registration key is purchased or otherwise legally obtained 
from Galleria Software or through RegSoft Inc, a software distributor of Galleria 
Sofware. 

B. Transfer: FrameMaster Licenses are not transferable. 

C. Copyright: The Software and Documentation are owned by Galleria Software. The 
Software and Documentation    are protected by United States and international 
copyright laws and international treaty provisions. You may not    remove, obscure, or 
alter any notice of patent, copyright, trademarks, trade secrets or other proprietary 
rights. 

D. Term: This License is effective until terminated. This License and your right to use 
this Software terminate automatically if you violate any part of this Agreement. 

E. Limitation of Liability Disclaimer: Galleria Software has made reasonable checks of 
this Software to confirm that it will perform in normal use on compatible equipment 
substantially as described in our Documentation, as published    most recently prior to 
your download of the Software. However, due to the inherently complex nature of 
computer    software, Galleria Software does not warrant that the Software or 
Documentation is completely error-free, will operate without interruption, is compatible 
with all equipment or software configurations, or will otherwise meet your needs. 
ACCORDINGLY, THE SOFTWARE AND DOCUMENTATION ARE PROVIDED AS-IS, 
AND YOU ASSUME ALL    RISKS ASSOCIATED WITH THEIR USE. 

Galleria Software MAKES NO OTHER WARRANTIES EXPRESSED OR IMPLIED, 
WITH RESPECT TO THE SOFTWARE OR THE DOCUMENTATION. 

In no event will Galleria Software be liable for indirect, incidental, or consequential 
damages, including, without limitations, the loss of income, use, or information, nor 
shall the liability of Galleria Software exceed the amount paid for this registration. 
Some localities do not allow the exclusion or limitation of incidental or consequential 
damages, so the above limitation or exclusion may not apply to you. You may also 
have other legal rights, which vary from place to place.





FrameMaster can read a variety of image formats.    The settings menu is used to set 
the directory paths for FrameMaster to use when opening and saving a file.    You can 
also paste an image from the Windows clipboard if you need to use a format that is 
not supported by FrameMaster.



FrameMaster supports writing files of the following image format type: JPEG, BMP, 
and GIF. The settings menu is used to set the directory paths for FrameMaster to use 
when opening and saving a file.    You may also copy a file to the Windows clipboard 
so that it may be used by another program.



You can select a region to crop by holding down the left mouse button and dragging 
the mouse.    Once you have done this, you can crop the image by selecting the Crop 
feature from the Edit menu.      Cropping will allow you to remove unwanted portions of 
a photo.

If you have added a frame or border effect and want to crop the framed image, you 
must first Apply the frame.    Applying the frame will also give the ability to layer 
frames.



When applying frames and border effects, the frames and border effects are not by 
default layered on top of each other.    Each new frame that is applied will replace with 
the old frame.    If however, you want to layer frames on top of existing frames, then 
you need to first apply the current frame. 



The Resize feature gives the ability to resize an unframed image.    This may be 
particularly useful if you are scanning in a photo that is extremely large.    Resizing 
can reduce/enlarge the image to the desired size.    If you want to resize a framed 
image you must first apply the frame, then you will have the ability to resize the 
image.



You can rotate an unframed image 90 degrees to the left and right, or 180 degrees.    
This is sometimes necessary when scanning photos since the photos may be laid out 
incorrectly.



You can zoom a photo when it is too large to view on screen.    This is sometimes 
necessary after scanning in a photo.    The Zoom feature does NOT resize the photo. 
If you want to crop an image but it is too large, you may want to zoom the photo to an 
appropriate size and then crop the photo.



The undo feature allows you to undo the last action that was performed.    Because of 
memory considerations, FrameMaster will only allow you to undo the last 10 actions.



Before scanning a photo for the first time, you must first select the appropriate source 
TWAIN driver.    The TWAIN driver is shipped with your scanning device and should 
be selected before scanning.    Note: If you get a message saying, “No TWAIN driver 
available”, it usually means that you haven’t installed the Windows TWAIN driver that 
came with your scanning device.    See manufacturer instructions for installing the 
TWAIN driver.



The settings menu can be used to adjust various directory paths.    The Source Image 
directory is the default directory for loading images.    The save directory is the default 
directory for saving images.

The Additional Masks directory is used if you have your own masks that you would 
like to use.    The Additional Overlays directory is used to locate additional Overlays.



FrameMaster allows you to scan pictures from scanning device. You may acquire an 
image from any twain-compatible device (this includes scanners, digital cameras, etc). 

You must first select your Image Source. This is done by selecting the “File” menu 
and then clicking on “Select Scan Source.” You will now see a list of twain drivers. 
Pick the appropriate driver. 

You can acquire an image by selecting Scan from the File menu. Once the image is 
acquired, the image will be automatically loaded into the image window.      See 
resizing for related info.



Inverts the photo’s color palette.    A color representing black will be inverted to white.



Converts the photo to grayscale (shades of gray).



FrameMaster can read the following image formats: JPG, BMP, GIF, PCX, TIF, PNG, 
TGA, PSP, PSD, PDD, RLE, DIB, PBM, CEL, PIC, and CUT.

FrameMaster can write image files using the following fromats: JPG, BMP, and GIF.



The Drop Shadow    effect will generate a shadow for the photo. You can select a 
realistic, solid, or pattern-filled shadow. You may also adjust the size of the shadow 
when using the non-realistic shadow.



This effect generates jagged edges for the photograph. You can change the size of 
the edges as desired. You may also alter the background. 



The Bubble Effect creates a series of semi-circles, spanning the perimeter of the 
photo. Theses semi-circles can be adjusted for size and can be filled with a solid color 
or pattern. 



Create a three-dimensional box effect. You can select either gradient or solid sides. 



A matte is simply a rectangular area surrounding the photo. The photo matte is easily 
adjustable and can be pattern filled. When creating a matte it may be desirable to 
apply a frame over the matte. This is accomplished by applying the matte and then 
selecting a frame.



The feature allows you to draw a four-cornered frame. The frame is easily resized and 
can be pattern filled or solid filled. 



The Buttonize effect is used to convert an image into a button. The image will 
resemble a three-dimensional button and will be shaded accordingly. This can be 
useful feature for creating buttons for web pages. 



The Oval effect can be used to convert a rectangular photo to an oval one.    An oval 
border can be created and you also have the ability to pattern-fill the background.



The Diamond Effect can be used to convert a rectangular photo to a diamond shape. 
A border can be created and you also have the ability to pattern-fill the background.



The Grayscale Effect can be used to convert an image to its grayscale equivalent.    
This effect will also allow you to partially grayscale parts of the photo, leaving other 
parts unaltered. 




